Using Multimedia In The Classroom

Tips, tricks, ideas, and helpful hints for using multimedia in your classroom.

Presented By

Rick Williams
Foothills Middle School
1410 Maple St.
Wenatchee, Wa. 98801
(509)664-8961
RLW@internet.wsd.wednet.edu
Using Multimedia In Our Schools

**What is multimedia?**

In the world of technology, multimedia involves integrating text, movies, pictures, photographs, animation, or sound into a product.

The use of multimedia in schools goes beyond fun and student motivation, although those are two important aspects. It can actually teach students how to access and productively use information. As with any other technology innovation, multimedia contains no magic of its own. It can become a valuable tool only when a teacher sees it as merely one element in a well-constructed learning environment. The emphasis should be on a practical and down-to-earth application of multimedia. One author (D'Ignazio, 1995) bases his findings on three years of classroom observation. He found that the teachers who were the most successful with multimedia introduced it in a learning environment which encouraged the simultaneous development of other supportive skills, including:

1. Cooperative learning
2. Higher order thinking skills
3. Group problem-solving
4. Risk-taking, improvisation, innovation
5. Oral and written communication skills
6. Learners taking responsibility for their own learning
7. Development of learners’ self-concept and self-esteem

In addition, teachers who were successful with multimedia used it as a tool for themselves as well as their students. Depending on their style, some teacher taught themselves multimedia; others learned it from their fellow teachers or from their students. Teachers who were successful found ways to use multimedia personally to:

1. Make presentations
2. Transform textbook materials into multimedia format
3. Conduct original research
4. Bring new life to “tired” knowledge, and
5. Renew their commitment to teaching

For additional information refer to:

“The One Minute Guru” [http://www.mudpie.org/course/mrapar01.htm](http://www.mudpie.org/course/mrapar01.htm) or Mary Fraundorf [http://www.coe.uh.edu/~mcf/m1future.html](http://www.coe.uh.edu/~mcf/m1future.html)

This presentation contains uses of multimedia that I have found to be successful with students. The areas that will be covered are:

1. HyperStudio
2. Avid Cinema
3. QTVR (Quicktime Virtual Reality using Nodester)
4. Using a digital camera
5. Using a scanner to help with multimedia projects
HyperStudio--A Great Tool For Curriculum Integration

As more schools have invested in technology for students, the question has shifted from how we teach students in a lab to how we integrate technology into the regular classroom. It becomes more of a task than just having hardware and software. It becomes a task of retraining teachers on how to construct an environment where students interact meaningfully with technology to pursue learning goals.

To make this shift, teachers need tools than can engage students and let them express their ideas in a variety of ways. HyperStudio is a software program that lets students work in many different ways. With HyperStudio students can add sound, text, graphics, animation, and video to classroom projects.

HyperStudio is content-independent so it can become a powerful player in a teachers quest to integrate technology into the curriculum. It allows students to choose which tools to use and under which circumstances to use them. It allows teachers the same freedom to expand or narrow student choices.

Stack Design Tips:
1. Be sure to key in on the real purpose of the stack you are creating. Buttons, graphics, and sound are important, but the real purpose should be to create experiences that convey emotions and information.
2. Create experiences that are memorable and meaningful. We remember best the experiences we have that are highly engaging and have a strong emotional component to them.
3. To create memorable stacks, we must know our audience. Is the project designed for young children, middle schooler's, or adults?
4. We can't forget that the main purpose of our project is to convey information. An appealing stack that conveys no new information will not be memorable.
HYPERSTUDIO PROJECT-- REVOLUTIONARY WAR

The following project will be done in groups of 2. Each group must pick one of the following topics.

Requirements:
1. Each HyperStudio stack must contain a Title Card. This title card must then link to a 2nd card which will show the authors and the date that the stack was done. (Extra credit if the authors picture is shown.
2. Each stack must contain a time-line showing the period from 1760 to 1783. Other world happenings during this time period should also be shown on your time line.
3. The information about your topic needs to be concise and easy to read. Spelling and punctuation errors need to be eliminated.
4. Each stack must contain a minimum of 3 scanned images that deal with your subject.
5. Each stack must have a conclusion card which should tell how and why these events were important to the history of the United States.
6. Each stack must have a bibliography card which lists all sources of information.
7. Movement through stack should be by buttons and each stack must contain a "Quit Button".

Topics:
2. British Colonial Policies:
   Proclamation of 1763; Sugar Act; Quartering Act; Stamp Act; Townshend Act; Writs of Assistance.
3. British Colonies in 1763*
   Which ones were they; how were they governed; life in the colonies.
4. Boston Massacre; Boston Tea Party:
   Tea tax Coercive Acts.
6. Lexington & Concord:
   First shots, what led up to it, results; Thomas Paine-- "Common Sense".
7. Declaration Of Independence*
   Thomas Jefferson

Grading:
Completed project is worth 215 points.

<table>
<thead>
<tr>
<th>Points</th>
<th>Excellent</th>
<th>Very Good</th>
<th>Good</th>
<th>Imp.</th>
<th>Not Done</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Research........50 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title Card.......................10 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Line........................10 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content...........................70 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scanned Images...............30 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conclusion Card..............15 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bibliography..................15 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ease of Navigation...........15 pts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A=193 points  B=172 points  C=150 points  D=129 points
A. Getting Started:

**Open HyperStudio folder:**
Double click on the application program. This opens up the HyperStudio **Home Stack**.

Click once on the **New Stack** button or click and hold on **File** in the menu bar and pull down to **New Stack**.

**Give stack a name:**
Click and hold on **File** and pull down to **Save Stack as**. Give your stack a name and select where you would like it saved.

**Set Preferences:**
Click and hold on **Edit** and pull the mouse down to **Preferences**. Do not check Presentation mode until you are finished with you stack.

**Set colors and size:**
Click and hold on **Objects** in the Menu Bar and pull the mouse down to **About This Stack**. Click on **Change # of colors or size** and select the size that you prefer.
Using the Tool Bar:
Click and hold on Tools in the menu bar and then drag down and across the screen and set your tool box where you want it. Below is a picture of the tool box and the names of each of the tools.

The Browse tool is used to activate buttons.

The Arrow tool edits or moves buttons, Graphic Objects, and Text Objects.

The Button tool edits or changes the buttons created.

The Graphic Object tool edits or moves Graphic Objects.

The Text Object tool moves or edits Text Objects.

The Square Selector tool captures rectangular areas.

The Circular Selector tool captures rectangular areas.

The Lasso tool captures an irregularly shaped area.

The Paintbrush tool will paint an area using the selected brush shape. Double-click the Paintbrush tool to show the Brush Shape dialog box.

The Spray Can tool sprays an area with a dotted pattern.
Text Tool (T in the tool box) or Text Field (Objects New Field):
When you use the Text Tool you are painting text on the screen and cannot make changes to it unless you erase it. Using of a Text Field allows you to type as you would in a word processing program. You can change the size of the text along with the style, color, and font.

Clip Art or Graphic Object:
Clip Art is very much like the Text Tool in that Clip Art is painted on the screen. Clip Art can be resized when you add it to a card (click on Edit and pull down to effects) but once you leave it you cannot come back to it and make size changes without erasing it. Placement of a Graphic Object allows you to move and resize that object any number of times. You can also delete a Graphic Object without ruining the card you are working with.

Import Background:
Import Background is found in the File menu. This allows you to select a picture that you want to use as a background for your card. The advantage to using Import Background is that the picture is automatically resized to fit your card.
Types of Buttons

This creates a rounded corner button.

This creates a rectangular shaped button.

This creates an invisible button
This allows you to click the mouse inside of an object and it will spread to the shape of the object. Great for maps.

This creates a button which also allows you to use the keyboard Return key.

This creates a rectangular shaped shadow button.

This allows you to use the pencil to define the shape of your button
This allows you to use the lasso to circle an object that you want as a button.
Which Cables do I Use?
You need both video and audio cables (if your stack contains audio) to connect your computer to your VCR.

**Composite**—Composite cables have RCA plugs—Red and White for audio and Yellow for Video.

**S-video**—Used to transfer video at a better picture quality than composite.

**S-video format**
For video, connect the S-video cable:
**From:** the computer’s S-video Out port
**To:** the VCR’s S-Video In port

For sound with the video, connect the Composite video/audio cable’s red and white ends.
**From:** the computer’s red and white Audio Out ports
**To:** the VCR’s red and white Audio In ports.

If your VCR has a single Audio In port connect the white cable to this port and do not use the red end.

**Composite video format**
For video, connect the Composite video/audio cable’s yellow ends.
**From:** the computer’s yellow Video Out port
**To:** the VCR’s yellow Video In port.

For sound with the video, connect the Composite video/audio cable’s red and white ends.
**From:** the computer’s red and white Audio Out ports
**To:** the VCR’s red and white Audio In ports.

If your VCR has a single Audio In port connect the white cable to this port and do not use the red end.

Use the **Control Strip** on your computer to turn TV Mirroring on.

Set the Standard to **NTSC** (PAL is for European use).

Turn on **Overscan** by releasing the mouse on Overscan.

VCR should be set to Auxiliary In or depending on VCR can be set to Line 1 or Line 2.
Minimum VCR/Computer Setup if a A/V Computer is not available.

Audio Mixer: The audio mixer receives audio signals from various sources--such as the computer and a microphone--and sends out a single audio signal. This is necessary since the VCR usually has only one audio input. The Multimedia Sound Recording Kit, from Roger Wagner, provides both the sound mixer and all the necessary cables.

S-video is used to get high resolution video signal
RCA/Phono is used to send both audio and video signals
BNC is used to send video signals. Used to make a tight connection
Using Avid Cinema

Avid Cinema is a video editing program that can be used to create not only stand-alone videos video projects that can be used in ClarisWorks, HyperStudio, and other applications that support QuickTime movies.

CREATING A MOVIE

VCR or Video Camera needs to be connected to the Video In of the computer.
S-cable or RCA Jacks will be used.
If the video that you are recording has sound make sure that the Audio cables are connected.

Open Avid Cinema

Double-click on the Avid Cinema program
When the program starts you have a choice of Planning A New Movie, Editing or Recording Tape, or Open Movie which allows you to continue working with a movie.

This option gives you suggestions about what you might want to include in your video and how long the video shots should be.

Clicking on \textit{Edit Existing Tape} allows you to bring video or pictures into Avid Cinema

Clicking on the \textit{Edit Existing Tape} button brings up a dialog box asking you to name your video and asking where you would like it saved.

Clicking on Bring Video In now allows you to record your video.

Click on record to create your video sequences. Click on stop when you are finished.

The recorded video can be given a name (in place of Untitled Shot 1)

You can record as many sequences as you need.
Click on **Edit Movie** and then click on **Import**. You will now be asked to locate your pictures. Import all of the pictures that you want to use.

Click on the movie sequence that you want to use and drag it to the movie line.

Clicking on a sequence will bring up handles on both ends of the sequence. These handles allow you to shorten your sequence. You can also move sequences by clicking and holding on the and moving it to its new location.

**Creating Effects**

Click on **Edit Movie** and then click on **Effects**.

Choose your **Effect** and then click on the **Apply** button.

The Effect will appear with handles on both ends. These handles allow you to shorten or lengthen the amount of time that the Effect is seen.

**Creating Titles**

These buttons are for style: Bold, Italic, Underline

These buttons are for alignment: Left, Center, Right.

**This box is where your Text is placed.**
Click on Apply after your title is completed.

A title is now placed in the Title track. It also shows the length of the Title—-it can be lengthened or shortened by clicking on the title.

Recording Sound

In the Sound tab you can:

Add tracks from music CDs to your movie.

Record narration over parts of your movie.

Adjust the volume of video, voice, or music clips; fade into or out of one of these clips.

The simplest way to add music to your movie is to “import” it from a music CD in your computer’s built-in CD drive.

Click and hold on Movie in the Menu Bar, pull mouse down to Audio Source and select CD.
• Place a music CD in your computer’s built-in CD player.
• Click the Sound tab.
• In the Timeline place the Position bar where you want the music to begin.
• Click The Import button.
• Choose the Music track you want.
• Click Open
• Use the slider to adjust how much of the track you want to import, and click the Play button to listen.
• Click OK when you are satisfied. The music is imported into the Music track of the Timeline.

You can also record sound from an audio cassette player, portable CD player, VCR, or another sound device with RCA audio ports such as a music synthesizer.
**Adding Narration**

- If your computer does not have a built-in microphone, plug a microphone into the computer’s microphone port. If you are using a monitor with a built-in microphone, plug the monitor cable labeled with a microphone into the computer’s microphone port.
- Choose Audio Source from the Movie Menu, then select Sound In or Built-In Mic from the Audio Source menu.
- In the Timeline, drag the Position bar to the place where you want the narration to begin.
- Click Record, and narrate the movie. The movie plays as you narrate.
- Click Stop where you are done. A Narration clip appears in the Voice track.

  - Click play in the Viewer window to review your work.
  - If you are satisfied, choose Save from the File Menu. If not, select the clip, choose clear from the Edit menu, and try again.

**Inserting Silence**:

- Select the clip following the cut where you want to insert silence.
- Choose Insert Silence from the Movie Menu.
- Choose Save from the File Menu.

**Splitting Clips**

Move the slider bar to the spot where you want to split the clip.

Click on Movie in the file menu and pull the mouse down Split Clip. You now have two clips. This can be done as many times as needed.

**Using The Zoom Feature**

Zooming out allows you to see all of your shots in one window--You can see how many shots you have.

Zooming in allows you to look in much greater depth at individual clips. This makes it easier to split clips.
Move the slider bar to where you want to insert the black--in this case it is at the start of the movie to be used for adding a title.

Click on Movie in the Menu Bar and pull the mouse down to Insert Black.

A dialog box now appears asking for how many seconds you want the black to appear. If it is for a title you might have to experiment with different times in order to get it to look good.

A blank space will now appear to indicate that you have inserted black. You can also remove the black by using the Movie File in the Menu Bar.

Click the mouse on the Send Movie Out Tab.

All titles that have been created must be digitized. This is done by clicking on the Preview full-screen and then on start. Once all of the titles have been digitized the movie can then be saved back to tape by clicking on Make videotape.

Clicking on Make videotape will bring up the directions for sending your video back to VCR tape.

If you have two sound tracks in your completed video make sure that you have connected the computer to the VCR with the dual stereo RCA jacks.

If you are recording from a computer without an RCA sound-out connection you will need to get a special adapter to plug into the Speaker Out connection on your computer. (Single plug in to computer to the stereo plug in of the VCR.)
Saving Avid Cinema For The Internet Or For Presentation:

Movies can also be saved for use on the Internet or for a presentation. Saving a movie for the Internet will give you a small format with a much smaller amount of space. Saving for presentation will give you a larger picture but will take up a larger amount of memory. Movies may also be saved for use on a CD Rom.

A movie I created in my Tech Lab used only 3.7 MB of memory when it was saved as an Internet movie.

The same movie saved for Presentation required 47.4 MB of hard drive memory but the size of the movie is better for viewing.
Using Photoshop to Scan Images

Open Photoshop and click on File. Go to import and select the ScanWizard PPC (This is the scanner I am using). Most scanners will have a plug-in that will work with Photoshop.

Clicking on preview will do a quick scan to show you the outline of your image. Use the mouse to move the dotted line rectangle so that it is only enclosing what you want scanned.

Now click on Scan. The scanned image will appear and you can now use the features of Photoshop to make any adjustments that need to be made.

The next pages will discuss some of those features.
The Brightness/Contrast feature allows you to create a brighter and sharper image. Experiment with both Brightness and Contrast to create the best possible image.

The Image Size feature found under the Image menu item is an extremely important feature when working with scanned images that will be placed in HyperStudio. A regular HyperStudio card is 512 pixels wide by 342 pixels high.

If your scanned image is wider or taller than 512 by 342 it will not fit on a regular HyperStudio card. Dimensions of 429 by 289 will fill about 3/4 of a card. Dimensions of 257 by 173 will fill about 1/4 of a regular card.

Change the pixel width and height by clicking on pixels and choosing percent (both width and height). Type in the percent you would like (it changes both) and click OK.

Saving Images

Save is found under the File Menu. In most cases you will select either the JPEG or PICT format. These will both work in HyperStudio.
Using A Digital Camera
In the Classroom

Using a Digital Camera
Digital cameras allow you to capture images in digital form and then transfer them to a computer to that you can save or manipulate them using image editing software.

Why Would You Use a Digital Camera in an Educational Setting?
1. The feedback is immediate--no more waiting to finish the film or for films to be developed.
2. Images can easily be enhanced, edited, resized, and stored.
3. After the initial purchase of the camera, costs are relatively inexpensive compared to normal photography costs.
4. Digital publishing is the medium of the future.
5. Digital photography is quicker than scanning in hard copy photographs.

How Do You Use a Digital Camera in a School Setting?
1. Load the software for the camera on to all computers the camera could be linked to or have one computer as the camera station.
2. Download the images as soon as one group has finished using the camera.
3. Save any images you want to floppy disk or hard drive.
4. Use a graphics program to edit images (Photoshop or Photo Deluxe).

When Can Students Start To Use a Digital Camera?
1. Students of most school ages can use a camera and a digital camera is as easy to use as any auto-focus model.
2. Students from age 8 should be able to download their images, save them and edit them with some guidance.
3. Guidance from a wiser person may be required when students and teachers first start using a digital camera and images.

Digital Cameras Have Many Uses Including: (These are just a few--add your own)
1. Enhancing newsletters, pamphlets, science reports. etc.
2. Getting images for web pages.
3. Self esteem activities (certificates, student of month).
4. Used to illustrate creative writing.
5. Take family pictures for unit on “my family”.
6. Student assignments across the curriculum.
7. Recording student progress.
8. Recording science projects.
9. Adding images to multimedia projects (HyperStudio).
10. E-mail attachments for global collaborative projects.
11. Archiving student photos over the years.
12. Creating QTVR (Quick Time Virtual Reality) panoramas.
13. Classroom brochures or flyers.
14. Presenting images on parents nights of students at work or play.
15. Class Portfolios
Using A Digital Camera

Parts of the camera:

Using the Camera: (The following information is for an Olympus digital camera but will apply to many of the different cameras that are available.)

1. To turn on the camera, open the lens cover. The camera will beep and the feature control icons will appear in the display.
2. To turn off the camera, close the lens cover.
3. The camera will revert to an inactive mode if no action is taken for 60 seconds. To return the camera to its active state, press and release the shutter button.
4. Most cameras will produce both normal quality images and high quality images. The mode button will allow you to set the type of quality that you want. (The Olympus produces 20 high quality and 80 normal quality pictures.

Note: The greater the number of pictures the longer the download time to the computer.
5. To erase all pictures--Push delete button and flash button simultaneously, then press the shutter button. The download software on your computer will also allow you to delete pictures.
6. To erase a single image--Select Picture, push delete button, then press shutter button.
Downloading Pictures
From Camera To Computer

Turn off the camera.

Connect one end of the communication cable to the computer’s serial port. (Normally the modem port. If you use the printer port Apple Talk must be turned off.)

Connect the other end to the camera.

Connect the Olympus external power source as this will save on battery use.

Turn on the camera.

Open your imaging software

Select the Olympus plugin (or the plugin for the type of camera you have) In Photoshop you choose file in the menu bar and then move down to import.

The Olympus Digital Vision splash screen displays while the thumbnails load from the camera to the computer.

The Olympus Digital Vision window displays the Contact Sheet, which contains thumbnails of the pictures stored in the camera.

You now have the following options: Select all--which selects all the pictures for download. Download--Brings pictures to computer. Erase--Remove pictures from camera.
CREATING QUICKTIME PANORAMAS
USING NODESTER FROM ROUNDBOARD LOGIC

Imagine that you are in the middle of a classroom. Now look around--left, right, up, and down. Zoom in and Zoom out. You can do all of these things with QuickTime VR. QuickTime VR is a quick and easy way to create interactive videos for use in the classroom or on the web. The following information centers on creating a panorama movie using the Nodester program from Roundabout Logic.

Nodester and its partner Widgetizer are user friendly programs that you use to create QuickTime panoramas and QuickTime object movies. A panorama movie allows you to view a scene in a 360 degree circle. An object movie allows you to view an object from the top, bottom, front, back and sides.

Nodester and Widgetizer are products of Roundabout Logic which will help you create a panorama or object movie.

Creating A QuickTime Panorama:

Open the Nodester program and then click on file Open. Click on the button on the right and then click open. This brings up a dialog box that allows you to choose the type of camera you are using.

Click the stationery button on the right and then click open.
Acquiring Images--

It is now time to acquire your images. A tripod that has a Kaidan panoramic head will be used. (It is possible to create panoramas by setting a camera on a lazy susan)

1. Attach the Kaidan head to the tripod.
2. Connect the camera (either our Olympus or Sony digital camera) to the Kaidan head. Make sure that you have followed the directions for setting correlating the nodal point of the camera and the panorama head.
3. Take your pictures--make sure that you are rotating the camera the correct number of degrees. (12 pictures requires 1 at every 30 degrees.)
4. Now that the picture taking is finished it is time to transfer them to the computer.
Transferring Images--
1. Connect the camera to the computer using the correct cables.
2. Use either Photoshop or the Olympus program to download your pictures from the camera. (Using Photoshop allows you to more easily manipulate your pictures. After opening Photoshop select import from the file menu and then select Olympus.)
3. You may have to rotate the pictures but again Photoshop allows you to easily do this.
4. Save the pictures as either JPG’s or Pict’s.

Creating A Panorama--
After opening Nodester and making sure that your input settings are correct you will then click on the frames tab.

Click on the multiple button and it will allow you to import all 12 of your pictures. They will be placed in a 360 degree circle.

Click on the Correlate tab and then click on Calculate.

Clicking on the Compose tab will allow you to set your compression. The default compression is set to Cinepak. Click on the set button and choose Motion JPEG and set quality to medium or high. Click OK after setting your compression.
Once you have created your movie you will then go to File in the menu bar and choose Export. Select either QuickTime VR 1.0 or 2.0 and check the Playable on non-Mac OS computers box. Then click Save.

You will want to experiment with different numbers of pictures, different size settings, and different compressions in order to determine what works best for you.

It is not necessary to use a tripod or a panoramic head in order to create QuickTime VR’s. Setting a lazy susan on top of a piece of tag board (on which you have used a protractor to set degree lines) works very well. My first panoramas were created in this manner.

Creating a Scene Using Apple VR Studio:

Creating a scene allows you to connect many different movies together by use of hot spots. Drag the QuickTime VR movie on to the Scene Maker screen. Use the Set Links buttons to connect movies--either one direction or both directions. Click and hold the mouse on a QuickTime movie and you will be allowed to create where in the other movie that you are linking to. Once all links have been set you will click on Make Scene and an interactive QuickTime VR movie will be produced.

The illustration on the left shows 17 movies that are connected. The final product is an inter-active tour of Foothills Middle School.
Internet LINKS

HyperStudio Resources:

Roger Wagner Home Page http://www.hyperstudio.com
Hyperstudio Journal http://www.hsj.com
Real Time HyperStudio on on the Internet
http://www.anoka.k12.mn.us/hyperstudio/realtime.html
Flecknology http://members.aol.com/tfleck/flecknology/
HyperStudio on the Net http://www.ties.k12.mn.us/~motylin/hstudio.html
HyperStudio Resource Center http://www.hyperstudio.com/resource/index.shtml#hypersites
HyperInternet http://k-12.pisd.edu/hyperstudio/hyperinternet.html
Color Tessellations http://forum.swarthmore.edu/sum95/suzanne/colortess.html
Collaborative HyperStudio Projects http://www1.minn.net/~schubert/HSPProjects.html
HyperStudio in Education http://www.hyperstudio.com/resource/hypersites/education.html
Share 105 http://www.share105.esd105.wednet.edu

Avid Cinema Links

Avid Cinema Home Page http://avidcinema.com/home/index.htm
Avid Cinema resources For Teachers http://rs6000.nshpl.library.ns.ca/~ggorveat/avid.html
Useful Links - Multimedia and Video Compression http://www.terran.com/info/Links.html

QTVR Links

QTVR: A Practical Guide http://www.si.umich.edu/QTVR/qtvrguide.html
VRtools QuickTime VR Streaming VR http://www.vrtools.com/
Intro to Quicktime VR - Basics http://www.dnai.com/~blanpied/qtvr_intro/qtvr basics.html
QTVR Online Virtual Tutor http://www.letmedoit.com/qtvr/qtvr_online/course_index.html
QuickTime VR Central http://www.quicktimefaq.org/qtvr/
Fraser's QuickTime VR http://w3.one.net/~a_frasermovies/qtvr.html

Sites to find QTVR movies:

nemeng VR Space http://www.nemeng.com/vr/index.html
Illinois State Museum--Uses of QTVR for Museums http://www.museum.state.il.us/qtvr/
Medius Interactive presents VR SEATTLE http://www.vrseattle.com/vrsea.home.html
Medius Interactive presents VR SEATTLE http://www.vrseattle.com/vrsea.home.html

Roundabout Logic (Nodester) http://www.roundaboutlogic.com
Kaidan (Panoramic tripod heads) http://www.kaidan.com
**Digital Camera Web Resources:**

**Photoshop Web Resources:**
http://www.adscape.com/eyedesign/photoshop/four/links/index.html#sites  
http://html.miningco.com/msubphotoshop.htm  
Photoshop from Educational Technology Resources  
http://www.esc20.tenet.edu/techserv/workshops/photoshop/default.html  
Ultimate Photoshop Contains good list of tutorials and help  
http://www.ultimate-photoshop.com/  